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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

• Thorough knowledge of Oracle navigation

• Working experience with inventory transactions

Prerequisites

• There are no prerequisites for this course.

How This Course Is Organized

This is an instructor-led course featuring lecture and hands-on exercises.  Online
demonstrations and written practice sessions reinforce the concepts and skills
introduced.
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Related Publications

Oracle Publications

Title Part Number

None

Additional Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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ObjectivesObjectives

After completing this module you should be able
to do the following:

• Create an ABC Compile
• Define and Maintain a Cycle Count
• Describe Serialized Cycle Counting
• Demonstrate Count Adjustments and Approvals

After completing this module you should be able
to do the following:

• Create an ABC Compile
• Define and Maintain a Cycle Count
• Describe Serialized Cycle Counting
• Demonstrate Count Adjustments and Approvals
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AgendaAgenda

• Overview of Cycle Counting and ABC Analysis
• Defining an ABC Analysis
• Defining and Maintaining a Cycle Count
• Understanding Serialized Cycle Counts
• Count Adjustments and Approvals
• Summary

• Overview of Cycle Counting and ABC Analysis
• Defining an ABC Analysis
• Defining and Maintaining a Cycle Count
• Understanding Serialized Cycle Counts
• Count Adjustments and Approvals
• Summary
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Overview of Cycle CountingOverview of Cycle Counting

• Cycle counting is the periodic counting of
individual items throughout the course of the year
to ensure the accuracy of inventory quantities and
values.

• You can perform cycle counting instead of taking
complete physical inventories, or you can use
both techniques to verify the accuracy of
inventory quantities and values.

• Cycle counting is the periodic counting of
individual items throughout the course of the year
to ensure the accuracy of inventory quantities and
values.

• You can perform cycle counting instead of taking
complete physical inventories, or you can use
both techniques to verify the accuracy of
inventory quantities and values.
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Overview of Cycle CountingOverview of Cycle Counting
• Inventory items are categorized by the system

according to the criterion designated (such as
Current Value or Forecasted Usage Quantity), into
as many ABC Classes as are specified (usually
between 3 and 6).  This process is called an “ABC
Compile”, and is used to get an overview of
existing inventory.

• ABC Classes can be used as they are by copying
them directly into ABC Assignment Groups, or
they can be adjusted to enhance cycle counting:

• Multiple ABC Classes can be combined into a
single ABC Assignment Group

– Individual items can be moved into a
different ABC Assignment Group than
would otherwise be assigned

• Inventory items are categorized by the system
according to the criterion designated (such as
Current Value or Forecasted Usage Quantity), into
as many ABC Classes as are specified (usually
between 3 and 6).  This process is called an “ABC
Compile”, and is used to get an overview of
existing inventory.

• ABC Classes can be used as they are by copying
them directly into ABC Assignment Groups, or
they can be adjusted to enhance cycle counting:

• Multiple ABC Classes can be combined into a
single ABC Assignment Group

– Individual items can be moved into a
different ABC Assignment Group than
would otherwise be assigned



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Cycle Counting
Chapter 1 - Page 7

Overview of Cycle Counting

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Overview of Cycle CountingOverview of Cycle Counting

• Items are loaded into Cycle Count Classes based
on their ABC Assignment Groups.  Cycle Count
Classes are the basis of all cycle count activity.
Cycle Count Classifications can be manually
adjusted.

• Count parameters (such as count frequency and
tolerance limits) are assigned to Cycle Count
Classes, which then drive count schedules and the
treatment of items with variances.

• Items are loaded into Cycle Count Classes based
on their ABC Assignment Groups.  Cycle Count
Classes are the basis of all cycle count activity.
Cycle Count Classifications can be manually
adjusted.

• Count parameters (such as count frequency and
tolerance limits) are assigned to Cycle Count
Classes, which then drive count schedules and the
treatment of items with variances.
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Overview of Cycle CountingOverview of Cycle Counting

• You can manually schedule cycle counts (i.e.: for
specific high-value subinventories or items) in
addition to automatically scheduled counts.

• Serialized items have additional support available
during the cycle count process, according to the
level specified.  This support ranges from “ignore
serial numbers” to “verify each serial number and
resolve any discrepancies”.

• You can manually schedule cycle counts (i.e.: for
specific high-value subinventories or items) in
addition to automatically scheduled counts.

• Serialized items have additional support available
during the cycle count process, according to the
level specified.  This support ranges from “ignore
serial numbers” to “verify each serial number and
resolve any discrepancies”.
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Overview of Cycle CountingOverview of Cycle Counting

• Items with count variances outside of specified
tolerance limits must be followed up as
designated:

– recount
– adjust
– approve adjustment (optional)

• Items with count variances outside of specified
tolerance limits must be followed up as
designated:

– recount
– adjust
– approve adjustment (optional)

••    Reports are available to manage the cycle     Reports are available to manage the cycle 
count process, ensure all items are counted, identifycount process, ensure all items are counted, identify
variances forvariances for followup followup and to report results. and to report results.
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Overview of ABC AnalysisOverview of ABC Analysis

• An ABC Analysis determines the relative
importance of a group of inventory items based on
user-specified criteria.

• An ABC Analysis is often used to drive cycle
counts, where you might count items of high value
(A items) frequently, items of lower value less
frequently (B items) and items of lowest value very
infrequently (C items).

• An ABC Analysis determines the relative
importance of a group of inventory items based on
user-specified criteria.

• An ABC Analysis is often used to drive cycle
counts, where you might count items of high value
(A items) frequently, items of lower value less
frequently (B items) and items of lowest value very
infrequently (C items).

“A” Item“A” Item“A” Item “B” Item“B” Item“B” Item “C” Item“C” Item“C” Item
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AgendaAgenda

• Overview of Cycle Counting and ABC Analysis
• Defining an ABC Analysis
• Defining and Maintaining a Cycle Count
• Understanding Serialized Cycle Counts
• Count Adjustments and Approvals
• Summary

• Overview of Cycle Counting and ABC Analysis
• Defining an ABC Analysis
• Defining and Maintaining a Cycle Count
• Understanding Serialized Cycle Counts
• Count Adjustments and Approvals
• Summary
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ABC Process FlowABC Process Flow

Define and run an ABC
compilation.

ABC Analysis Process Steps

Define ABC classes.

Define ABC group, assign items to
ABC classes within a group.

Update item assignments.

Purge ABC information.

1

2

3

4

5
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Defining an ABC AnalysisDefining an ABC Analysis

• Define and run an ABC compilation.
• Run the Descending Value Report.
• Define ABC Classes.
• Define ABC Groups.
• Assign items to ABC classes within a group.
• Update item assignments.

• Define and run an ABC compilation.
• Run the Descending Value Report.
• Define ABC Classes.
• Define ABC Groups.
• Assign items to ABC classes within a group.
• Update item assignments.

The steps involved in performing a successful ABCThe steps involved in performing a successful ABC
Analysis are:Analysis are:
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Define and Run an ABC CompilationDefine and Run an ABC Compilation

• An ABC Compile is a ranking of your items based
upon selected criteria.

• You can define and compile an ABC analysis for
your entire organization or for a specific
subinventory within your organization.

• An ABC Compile is a ranking of your items based
upon selected criteria.

• You can define and compile an ABC analysis for
your entire organization or for a specific
subinventory within your organization.

“A” Item“A” Item“A” Item “B” Item“B” Item“B” Item “C” Item“C” Item“C” Item

You choose the compilation criterion, the scope of your analysis, the cost type to
use in determining item values and any additional information that  may be
conditionally necessary based on your compilation criterion.
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ABC Compilation CriteriaABC Compilation Criteria

• For each distinct compile, you can choose one
criterion (such as Current On-Hand Value or MRP
Demand Usage Value - see following pages) to
value and rank each item included in the ABC
compile.

• The criterion that you choose defines what the
rank of a particular item will be in the ABC
Compile.

• For each distinct compile, you can choose one
criterion (such as Current On-Hand Value or MRP
Demand Usage Value - see following pages) to
value and rank each item included in the ABC
compile.

• The criterion that you choose defines what the
rank of a particular item will be in the ABC
Compile.

For example:  If you use Current on-hand quantity as your compile criterion,
then item X with an on-hand quantity of 10 units is of higher rank than item Y
with a quantity of 5 units.  If you use Current on-hand value criterion item X has
a cost of $10 per unit and item Y has a cost of $25 per unit, item Y has a higher
value than item X since Oracle Inventory compares $100 ($10x10 units) to $125
($25x5 units).



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Cycle Counting
Chapter 1 - Page 16

ABC Compilation Criteria

Copyright  Oracle Corporation, 2000. All rights reserved.
®

 ABC Compilation Criteria ABC Compilation Criteria

• Current on-hand Quantity: Use the current on-
hand quantity of inventory.  Assign the sequence
number by descending quantity.

• Current on-hand Value: Use the current on-hand
quantity of inventory multiplied by the cost for the
cost type.  Assign the sequence number by
descending value.

• Historical Usage Value: Use the historical usage
value (transaction history).  This is the sum of the
transaction quantities times the unit cost of the
transactions for the time period you specify.
Assign the sequence number by descending
value.

• Current on-hand Quantity: Use the current on-
hand quantity of inventory.  Assign the sequence
number by descending quantity.

• Current on-hand Value: Use the current on-hand
quantity of inventory multiplied by the cost for the
cost type.  Assign the sequence number by
descending value.

• Historical Usage Value: Use the historical usage
value (transaction history).  This is the sum of the
transaction quantities times the unit cost of the
transactions for the time period you specify.
Assign the sequence number by descending
value.

Note:  Any value based criterion requires you to nominate a cost type.
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ABC Compilation CriteriaABC Compilation Criteria

• Historical Usage Quantity: Use the historical
usage quantity (transaction history) for the time
period you specify.  Assign the sequence number
by descending quantity.

• Historical Number of Transactions: Use the
historical number of transactions (transaction
history) for the time period you specify.  Assign
the sequence number by descending number of
transactions.

• Forecasted Usage Value: Use the forecasted
usage value based on the forecast quantity
calculated and the cost type you specify.  Assign
the sequence number by descending value.

• Historical Usage Quantity: Use the historical
usage quantity (transaction history) for the time
period you specify.  Assign the sequence number
by descending quantity.

• Historical Number of Transactions: Use the
historical number of transactions (transaction
history) for the time period you specify.  Assign
the sequence number by descending number of
transactions.

• Forecasted Usage Value: Use the forecasted
usage value based on the forecast quantity
calculated and the cost type you specify.  Assign
the sequence number by descending value.
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ABC Compilation CriteriaABC Compilation Criteria

• Forecasted Usage Quantity: Use the forecasted
usage quantity.  Assign the sequence number by
descending quantity.

• Previous Cycle Count Adjustment Quantity: Oracle
Inventory sums the value of all cycle count
adjustments since the last ABC compile date.
Assign the sequence number by descending
quantity.

• Previous Cycle Count Adjustment Value: Oracle
Inventory sums the value of all cycle count
adjustments since the last ABC compile date.
Assign the sequence number by descending
value.

• Forecasted Usage Quantity: Use the forecasted
usage quantity.  Assign the sequence number by
descending quantity.

• Previous Cycle Count Adjustment Quantity: Oracle
Inventory sums the value of all cycle count
adjustments since the last ABC compile date.
Assign the sequence number by descending
quantity.

• Previous Cycle Count Adjustment Value: Oracle
Inventory sums the value of all cycle count
adjustments since the last ABC compile date.
Assign the sequence number by descending
value.
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ABC Compilation CriteriaABC Compilation Criteria

• MRP Demand Usage Quantity: Oracle Inventory
sums the MRP gross requirements for the MRP
plan you specify.  Assign the sequence number by
descending quantity.

• MRP Demand Usage Value: Oracle Inventory sums
the MRP gross requirements for the MRP plan you
specify,  then multiplies each by the item cost type
you choose in the ABC compile form.  Assign the
sequence number by descending value.

• MRP Demand Usage Quantity: Oracle Inventory
sums the MRP gross requirements for the MRP
plan you specify.  Assign the sequence number by
descending quantity.

• MRP Demand Usage Value: Oracle Inventory sums
the MRP gross requirements for the MRP plan you
specify,  then multiplies each by the item cost type
you choose in the ABC compile form.  Assign the
sequence number by descending value.
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ABC Valuation ScopeABC Valuation Scope

• You select a valuation scope for determining the
ranking of items.

• Valuation Scope is chosen in the Define ABC
Compile window.

• If you choose to restrict your ABC compile to
items within a particular subinventory, you have
the option of valuing your items across all
subinventories in the organization or just the one
for which you have restricted the ABC compile.

• You select a valuation scope for determining the
ranking of items.

• Valuation Scope is chosen in the Define ABC
Compile window.

• If you choose to restrict your ABC compile to
items within a particular subinventory, you have
the option of valuing your items across all
subinventories in the organization or just the one
for which you have restricted the ABC compile.
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The Descending Value ReportThe Descending Value Report

• You use the ABC Descending Value Report to view
the results of your ABC compile.

• The report is sorted by descending value or
quantity, depending on the compile criterion.

• You use this report to evaluate the break points for
assigning your ABC item to classes.

• You use the ABC Descending Value Report to view
the results of your ABC compile.

• The report is sorted by descending value or
quantity, depending on the compile criterion.

• You use this report to evaluate the break points for
assigning your ABC item to classes.
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Defining ABC ClassesDefining ABC Classes

• You use ABC classes to identify the value
groupings to which your items belong.

• You define these classes using your own
terminology.  For example, you might define
classes High, Medium, Low.  Later assign your
items of highest rank to the High class, those of
lower rank to the Medium class and those of
lowest rank to the Low class.

• You can add to the list of classes you have already
defined at any time.

• You use ABC classes to identify the value
groupings to which your items belong.

• You define these classes using your own
terminology.  For example, you might define
classes High, Medium, Low.  Later assign your
items of highest rank to the High class, those of
lower rank to the Medium class and those of
lowest rank to the Low class.

• You can add to the list of classes you have already
defined at any time.
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Defining ABC ClassesDefining ABC Classes

• You can use ABC classes to group items for a
cycle count where you count “A” items more
frequently than “B” items.  When  you use ABC
classes in this way, you perform an ABC analysis
and assign items to classes based on the results
of that analysis.

• You can also use ABC classes to group items for
planning purposes.  For example, the Planning
Detail Report allows you to choose an ABC class
to report on.

• You can use ABC classes to group items for a
cycle count where you count “A” items more
frequently than “B” items.  When  you use ABC
classes in this way, you perform an ABC analysis
and assign items to classes based on the results
of that analysis.

• You can also use ABC classes to group items for
planning purposes.  For example, the Planning
Detail Report allows you to choose an ABC class
to report on.
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Defining ABC ClassesDefining ABC Classes

• You can delete an ABC class as long as the class
is not in use in a cycle count or ABC assignment
group.

• You can make an ABC class inactive by entering a
date on which the class becomes inactive.  As of
this date, you can no longer assign the ABC class
to an ABC group.

• You can delete an ABC class as long as the class
is not in use in a cycle count or ABC assignment
group.

• You can make an ABC class inactive by entering a
date on which the class becomes inactive.  As of
this date, you can no longer assign the ABC class
to an ABC group.
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Defining ABC GroupsDefining ABC Groups

• ABC assignment groups link a particular ABC
compile with a valid set of ABC classes.  This
allows you to selectively reduce or increase the
number of ABC classes you want to use in your
item assignments for a particular ABC compile.

• Oracle Inventory uses these groups when you
automatically assign your items to ABC classes.  It
ensures that you divide your items into the exact
number of groupings you specified in the ABC
group.

• ABC assignment groups link a particular ABC
compile with a valid set of ABC classes.  This
allows you to selectively reduce or increase the
number of ABC classes you want to use in your
item assignments for a particular ABC compile.

• Oracle Inventory uses these groups when you
automatically assign your items to ABC classes.  It
ensures that you divide your items into the exact
number of groupings you specified in the ABC
group.
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• You must also assign a sequence number to each
class associated with the ABC group.  The class
with the lowest sequence number is assumed to
have the highest rank and will have higher rank
items assigned to that class than the next higher
sequence number.

• You may update an assignment group to add new
classes, however you cannot delete a class.  If you
need to delete a class, you must create a new
assignment group with only the desired classes.

• You must also assign a sequence number to each
class associated with the ABC group.  The class
with the lowest sequence number is assumed to
have the highest rank and will have higher rank
items assigned to that class than the next higher
sequence number.

• You may update an assignment group to add new
classes, however you cannot delete a class.  If you
need to delete a class, you must create a new
assignment group with only the desired classes.
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ABC Item AssignmentsABC Item Assignments

• When you define ABC assignments you specify
the cutoff point for each ABC class.  Each ABC
class must have at least one item assigned to it
and all items in the ABC compile must be assigned
to an ABC class.  You can use any of the following
fields to determine the cutoff points:

• Seq: You can enter the sequence number from
the ABC Descending Value Report for the last item
to be included in each ABC class.  Oracle
Inventory automatically calculates this value if you
choose to assign classes by another method.
Oracle Inventory displays the last sequence
number as the default of the last class.

• When you define ABC assignments you specify
the cutoff point for each ABC class.  Each ABC
class must have at least one item assigned to it
and all items in the ABC compile must be assigned
to an ABC class.  You can use any of the following
fields to determine the cutoff points:

• Seq: You can enter the sequence number from
the ABC Descending Value Report for the last item
to be included in each ABC class.  Oracle
Inventory automatically calculates this value if you
choose to assign classes by another method.
Oracle Inventory displays the last sequence
number as the default of the last class.
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Inventory Value: You can enter the cumulative
value from the ABC Descending Value Report for
the last item to include in each ABC class.  Oracle
Inventory automatically calculates the maximum
value.  This maximum value is restricted to the
total inventory value compiled and is displayed in
the Total Compile Value field.  Oracle Inventory
displays the total inventory value as the default for
the last class.

Inventory Value: You can enter the cumulative
value from the ABC Descending Value Report for
the last item to include in each ABC class.  Oracle
Inventory automatically calculates the maximum
value.  This maximum value is restricted to the
total inventory value compiled and is displayed in
the Total Compile Value field.  Oracle Inventory
displays the total inventory value as the default for
the last class.
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% Items:  You can enter the percent of number of
items compiled from the ABC Descending Value
Report to include in each class.  Oracle Inventory
automatically calculates this value if you choose
to assign classes by another method.
% Value:  You can enter the percent of total
compile value from the ABC Descending Value
Report to include in each class.  Oracle Inventory
automatically calculates this value if you choose
to assign classes by another method.

% Items:  You can enter the percent of number of
items compiled from the ABC Descending Value
Report to include in each class.  Oracle Inventory
automatically calculates this value if you choose
to assign classes by another method.
% Value:  You can enter the percent of total
compile value from the ABC Descending Value
Report to include in each class.  Oracle Inventory
automatically calculates this value if you choose
to assign classes by another method.

Note:  It is possible to have several items in the ABC compile with zero value.  If
any item with zero value is in a class other than the last class, you may only
assign items using the sequence number or item percent.
For the Inventory Value, % Item and % Value fields, if the value entered does not
exactly match any item, Oracle Inventory chooses the first item with a value
greater than the value entered.  For example, if you choose 20% to be A items,
inventory calculates which items comprise 20% and will include the next item if a
partial is in the calculation.  If 20% = the first 10 items in my compile, plus part
of the 11th item, then items 1-11 are A items.
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If you are not satisfied with the class into which an
item falls as a result of the automatic ABC
assignment process, you can change it.  For
example, you compile your ABC analysis based on
historical usage value.  A new item in your
inventory is ranked low because it has little
transaction history.  However, you know that for
the future this item should really be ranked higher.
Use the Update ABC Assignments form to
reclassify this item.

If you are not satisfied with the class into which an
item falls as a result of the automatic ABC
assignment process, you can change it.  For
example, you compile your ABC analysis based on
historical usage value.  A new item in your
inventory is ranked low because it has little
transaction history.  However, you know that for
the future this item should really be ranked higher.
Use the Update ABC Assignments form to
reclassify this item.

Note:  Whenever you recompile an ABC analysis or change the method by
which you assign your ABC classifications, you lose any changes you might have
made to your item assignments.  All items are reclassified based on their new
ranks in the ABC Descending Value Report and the method you choose to
determine cutoff points.
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You can also update an ABC group to include
those items that were not a part of the initial ABC
compile.  This allows you to expand the scope of
your existing ABC compiles without having to
rerun any processes.

You can also update an ABC group to include
those items that were not a part of the initial ABC
compile.  This allows you to expand the scope of
your existing ABC compiles without having to
rerun any processes.
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Purging ABC InformationPurging ABC Information

• You can submit a request to purge either an ABC
assignment group or ABC compile information.

• Purging an ABC group deletes all item
assignments to ABC classes for the assignment
group you specify, as well as the ABC group itself.

• Purging an ABC compile deletes all item values
and rankings for the ABC compile you specify, as
well as the ABC compile itself.

• You can purge an ABC compile only if no ABC
groups are using it.

• You can submit a request to purge either an ABC
assignment group or ABC compile information.

• Purging an ABC group deletes all item
assignments to ABC classes for the assignment
group you specify, as well as the ABC group itself.

• Purging an ABC compile deletes all item values
and rankings for the ABC compile you specify, as
well as the ABC compile itself.

• You can purge an ABC compile only if no ABC
groups are using it.
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• Define and run an ABC Compile
• Run the Descending Value Report
• Define ABC Classes
• Define ABC Groups
• Assign Items

• Define and run an ABC Compile
• Run the Descending Value Report
• Define ABC Classes
• Define ABC Groups
• Assign Items
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Practice 1 Solutions
1.  Define and Run an ABC Compile
Manufacturing and Distribution Manager Responsibility    (N)
Inventory > ABC Codes > ABC Compile (B) New
Enter a unique name and description.
Select “Subinventory” under Content Scope.
From the list of values, choose a subinventory.
Select “Subinventory” under Valuation Scope.
Select “Current On-Hand Value” under Compile Specification.
Select “Frozen” under Cost Type.  (Frozen is only a valid option when the
organization is standard costed)
Press the “Compile” button.
Press “OK” in the confirmation window.
Select “NO” when asked to print.
View your request to make sure it completed without error.
(N)View > Requests
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Practice 1 Solutions
2.  Run the Descending Value Report
Manufacturing and Distribution Manager Responsibility    (N)
Inventory > reports > ABC and Counting
Select Single Request
Report Name = ABC Descending Value Report
ABC Compile Header = Your Compile Name from step 1
Cumulative Display Criteria = Cumulative By Value
(B)OK
(B)Submit
When asked to Submit Another Request, select “NO”
View your request to make sure it completed without error.
(N)View > Requests
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Practice 1 Solutions
3.  Define ABC Classes
Manufacturing and Distribution Manager Responsibility    (N)
Inventory > ABC Codes > ABC Classes
DO NOT TYPE OVER EXISTING DATA!
You will enter three classes in this screen.
Enter a unique name and description for your “A” class.
Enter a unique name and description for your “B” class.
Enter a unique name and description for your “C” class.
Save your work.
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Practice 1 Solutions
4.  Define ABC Groups
Manufacturing and Distribution Manager Responsibility    (N)
Inventory > ABC Codes > ABC Assignment Group
Enter a unique Group Name.
Enter your ABC Compile Name.
The “Subinventory” and “Valuation Scope” information will be populated by with
default information.
Save your work.
(B)Group Classes
The Priority fields will populate with default numbers.
Tab to Class Name field
Enter your “A” Class Name or choose it from the list of values
Repeat for your “B” and “C” Class Names
Save your work.
Close the Group Class Assignment Window.
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Practice 1 Solutions
5.  Assign Items
Manufacturing and Distribution Manager Responsibility    (N)
Inventory > ABC Codes > ABC Assignment Group
(B)Assign Items
Enter the following In the “% Items” field: (This is a cumulative column)
60, 80, 100
(B)Assign
A concurrent request will be submitted
(B)OK
Note your request number
Close the Assign ABC Items Window
View your request to make sure it completed without error.
(N)View > Requests
After your request has completed, press the “Update Items” button.
Review the results of the item assignment.
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• Overview of Cycle Counting and ABC Analysis
• Defining an ABC Analysis
• Defining and Maintaining a Cycle Count
• Understanding Serialized Cycle Counts
• Count Adjustments and Approvals
• Summary

• Overview of Cycle Counting and ABC Analysis
• Defining an ABC Analysis
• Defining and Maintaining a Cycle Count
• Understanding Serialized Cycle Counts
• Count Adjustments and Approvals
• Summary
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Defining and Maintaining a Cycle CountDefining and Maintaining a Cycle Count

Establish Tolerances & other limits

Cycle Count Steps

Load Items to be counted into
Cycle Count Classes

Schedule Counts and generate
Count Requests

Enter Counts and report results

Manage Count interface processes

1

2

3

4

5
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Cycle Count Approval ToleranceCycle Count Approval Tolerance

• A cycle count is a count of a subset of items,
counted during the working day, rather than after
freezing stock levels.

• When the actual count and the system’s on-hand
quantity  do not exactly agree, the cycle count will
be compared to an approval tolerance.

• A cycle count is a count of a subset of items,
counted during the working day, rather than after
freezing stock levels.

• When the actual count and the system’s on-hand
quantity  do not exactly agree, the cycle count will
be compared to an approval tolerance.
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• Oracle Inventory supports two types of cycle
count approval tolerances, Quantity Variance
Tolerance and Adjustment Value Tolerance.  For
each type, you can specify a positive and a
negative limit which can differ from each other.

• When a particular cycle count entry results in an
adjustment that exceeds any one of these limits,
you have a cycle count adjustment that exceeds
approval tolerances.

• Based on the approval option you choose when
you define your cycle count, this adjustment is
either posted automatically or held for approval.

•• Oracle Inventory supports two types of cycleOracle Inventory supports two types of cycle
count approval tolerances, count approval tolerances, Quantity VarianceQuantity Variance
ToleranceTolerance and  and Adjustment Value ToleranceAdjustment Value Tolerance.  For.  For
each type, you can specify a positive and aeach type, you can specify a positive and a
negative limit which can differ from each other.negative limit which can differ from each other.

•• When a particular cycle count entry results in anWhen a particular cycle count entry results in an
adjustment that exceeds any one of these limits,adjustment that exceeds any one of these limits,
you have a cycle count adjustment that exceedsyou have a cycle count adjustment that exceeds
approval tolerances.approval tolerances.

•• Based on the approval option you choose whenBased on the approval option you choose when
you define your cycle count, this adjustment isyou define your cycle count, this adjustment is
either posted automatically or held for approval.either posted automatically or held for approval.
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Quantity Variance Tolerance:
• The quantity variance tolerance is a user-defined

limit for the difference between the actual cycle
count quantity and the system tracked on-hand
quantity.  You express positive and negative
quantity variance tolerances as percentages of the
system on-hand quantity.

• You enter these percentages when you define
your:
— Cycle Count Header
— Cycle Count Classes
— Cycle Count Items

Quantity Variance Tolerance:
• The quantity variance tolerance is a user-defined

limit for the difference between the actual cycle
count quantity and the system tracked on-hand
quantity.  You express positive and negative
quantity variance tolerances as percentages of the
system on-hand quantity.

• You enter these percentages when you define
your:
— Cycle Count Header
— Cycle Count Classes
— Cycle Count Items

Note:  Inventory uses any percentages you define at the cycle count item level
first.  If you do not have any defined for an item, it uses the tolerances defined for
that item’s cycle count class.  If you do not have any defined for the class, it uses
the tolerances at the cycle count header level.  If you have no tolerances defined
for the header, Inventory assumes that there is no limit to the approval tolerance.
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Adjustment Value Tolerance:
• The Adjustment Value Tolerance is a user-defined

limit for the total value of a cycle count
adjustment.

– The adjustment value is calculated as:
adjusted value = (count qty - system on-
hand qty) * current item cost

• The Adjustment Value Tolerance is expressed as
positive and negative amounts in your functional
currency.  An adjustment value is out of tolerance
if it falls outside of these amounts.

• You enter these tolerances when you define your
cycle count header and cycle count classes.

Adjustment Value Tolerance:
• The Adjustment Value Tolerance is a user-defined

limit for the total value of a cycle count
adjustment.

– The adjustment value is calculated as:
adjusted value = (count qty - system on-
hand qty) * current item cost

• The Adjustment Value Tolerance is expressed as
positive and negative amounts in your functional
currency.  An adjustment value is out of tolerance
if it falls outside of these amounts.

• You enter these tolerances when you define your
cycle count header and cycle count classes.

Note:  Inventory uses the values you define at the cycle count class level first.  If
you do not have any defined for an item’s class, it uses the values at the cycle
count header level.  If you have no tolerances defined for the header, Inventory
assumes that there is no limit to the approval tolerance.
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Hit/Miss Tolerance:
• The Hit/Miss Tolerance is a user-defined limit for

the difference between the system tracked on-
hand quantity and the actual cycle count quantity.

• You express positive and negative hit/miss
tolerances as percentages of the system on-hand
quantity.

• A count is considered a “hit” if it is within these
tolerances, and a “miss” if it is outside them.

• The Hit/Miss Tolerance allows you to evaluate the
actual accuracy of your inventory.

Hit/Miss Tolerance:
• The Hit/Miss Tolerance is a user-defined limit for

the difference between the system tracked on-
hand quantity and the actual cycle count quantity.

• You express positive and negative hit/miss
tolerances as percentages of the system on-hand
quantity.

• A count is considered a “hit” if it is within these
tolerances, and a “miss” if it is outside them.

• The Hit/Miss Tolerance allows you to evaluate the
actual accuracy of your inventory.

Note:  You enter hit/miss tolerance percentages when you define your cycle
count header and when you define your cycle count classes.  Inventory uses the
percentages you define at the cycle count class level first.  If you do not have any
defined for an item’s class, it uses the tolerances at the cycle count header level.
If you have no tolerances defined for the header, Inventory assumes that there is
no limit to the hit/miss tolerance, and all variances are therefore “hits” regardless
of the size.
Inventory uses these tolerances to generate the Cycle Count Hit/Miss Analysis
report which will be covered later in this course.
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Measurement Errors:
• Negative and positive measurement errors are

user-defined limits for the difference between the
cycle count quantity and the system tracked on-
hand quantity.  Measurement Error limits are
assigned by Item.

• Inventory does not make any adjustments to an
item whose cycle count quantity differs from the
system tracked on-hand quantity by less than the
measurement error.  Because of this,
measurement errors implicitly override any
approval tolerances you specify.

Measurement Errors:
• Negative and positive measurement errors are

user-defined limits for the difference between the
cycle count quantity and the system tracked on-
hand quantity.  Measurement Error limits are
assigned by Item.

• Inventory does not make any adjustments to an
item whose cycle count quantity differs from the
system tracked on-hand quantity by less than the
measurement error.  Because of this,
measurement errors implicitly override any
approval tolerances you specify.

Note:  You specify measurement errors when you define or update an item at the
Master Item or Organizational Item level.  Use measurement errors with extreme
caution since they actually prevent cycle count adjustments from taking place.
You would typically use this feature on an exception basis for items you cannot
accurately count.  For example, if you visually check the level of bolts in a bin to
estimate the quantity, or you use their weight to approximate the quantity, you
might want to allow for measurement errors.  Therefore, if your system tracked
on-hand quantity for the bolts in that bin is within an acceptable range, you do not
perform a cycle count adjustment.
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• You need to load items into your cycle count
before you can schedule or count them.  There are
two methods you can use to do this.

• specify an existing ABC group from which to
automatically load your items
– manually enter, delete or update the items you

want included/excluded

• You need to load items into your cycle count
before you can schedule or count them.  There are
two methods you can use to do this.

• specify an existing ABC group from which to
automatically load your items
– manually enter, delete or update the items you

want included/excluded

When you specify an existing ABC group, Oracle Inventory automatically
includes all items in the ABC group you choose in your cycle count.  Inventory
also copies the ABC classes for that ABC group into the current cycle count
classes and maintains the same classifications for the included items.  You can
change the classifications of your items for your cycle count independent of the
ABC classes.
Once you have generated your list of items to count from an ABC group, you can
periodically refresh the item list with new or reclassified items from a regenerated
ABC group.  Using the Cycle Counts window, you can choose whether to
automatically update class information for existing items in the cycle count based
on the  new ABC assignments.  You can also choose to have any items that are no
longer in the ABC group automatically deleted from the cycle count list.
You manually enter, delete, or update the items you want included/excluded
using the Cycle Count Items window.  You may want to use this form to load all
your items for a cycle count or to simply add items as they are defined in the
system rather than recompiling your ABC group and doing a complete
reinitialization.
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Oracle Inventory uses the number of items in each
cycle count class, the frequency of each class,
and the workday calendar of your organization to
determine how many and which items you need to
count during the scheduling frequency.

Oracle Inventory uses the number of items in each
cycle count class, the frequency of each class,
and the workday calendar of your organization to
determine how many and which items you need to
count during the scheduling frequency.

In order for Inventory to perform automatic scheduling you must:
• Set the Cycle Count Enabled item attribute to Yes for the items you 

want to include in the cycle count.
• Enable automatic scheduling when you define your cycle count.
• Request the schedule using the Generate Automatic Schedule 

Requests window.
• Each time the auto scheduler runs, it schedules counts only for the schedule
interval you defined for the cycle count header.  So if your schedule interval is
weeks, Inventory schedules all items that you need to be counted on all of the
workdays in the current week.  If your schedule interval is days, then Inventory
only schedules those items that are due for counting on the current date.
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Manual SchedulingManual Scheduling

You can manually schedule counts in addition to
or instead of those generated with automatic
scheduling.

You can manually schedule counts in addition to
or instead of those generated with automatic
scheduling.

You can request counts for specific subinventories, locators and items, and set the
count for any inventory date.  For example, you could enter a request to count
item A wherever it can be found in subinventory X.  Or you could request to
count all item quantities in subinventory Y, locator B-100.
Since manually scheduled counts have no impact on automatically scheduled
counts, you can potentially count some items more frequently than you had
initially planned.
Physical Location Scheduling
You can use this feature to execute location-based cycle counting.  You first need
to generate a schedule for counting each subinventory and locator.  You then need
to enter the schedule requests for each locator, specifying the schedule date.
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Count RequestsCount Requests

After you have successfully scheduled your
counts, you can submit the process to generate
count requests.

After you have successfully scheduled your
counts, you can submit the process to generate
count requests.

This process takes the output of the automatic scheduler and your manual
schedule entries and generates a count request for each item number, revision, lot
number, subinventory and locator combination for which on-hand quantities exist.
These count requests are ordered first by subinventory and locator, then by item,
revision and lot.  Oracle Inventory assigns a unique sequence number to each
count request that can be used for reporting, querying and rapid count entry.
Because the count requests are derived from the state of on-hand balances at the
time the Generate Cycle count Requests process is run, you should wait to run it
until you are ready to count.
Note: When you schedule an item to be counted using manual scheduling, some
schedule requests may have overlapping count requirements.  The count request
generator does not create duplicate count requests, but instead cross-references
one count request back to each associated schedule request.
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By default Inventory does not automatically
generate requests to count items with an on-hand
quantity of zero.  To include such items:

• Define all sourcing details and inventory controls
for the item.  (For example, if an item is under
predefined locator control be sure it is assigned to
a subinventory and locator.)

• Select the Generate Zero Counts option when you
define your cycle count.

By default Inventory does not automatically
generate requests to count items with an on-hand
quantity of zero.  To include such items:

• Define all sourcing details and inventory controls
for the item.  (For example, if an item is under
predefined locator control be sure it is assigned to
a subinventory and locator.)

• Select the Generate Zero Counts option when you
define your cycle count.

The count request generation process automatically creates a count request.  If a
quantity is found and counted, an adjustment is made.
At count entry, you may receive a warning message stating “Zero count, no
adjustment performed.”  Inventory generates this warning if it cannot find all
levels of inventory control defined for the item.  In this situation, enter the count
but no adjustment is performed.  To make an adjustment and update the missing
information, enter an unscheduled count using either the Cycle Count Entries or
Approve Adjustments window.
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Entering Cycle CountsEntering Cycle Counts

• You can use the same window to enter counts of
items requested via automatic or manual cycle
count scheduling.

• You can also enter unscheduled count entries, if
they are allowed for your cycle counts.

• You can use unscheduled counts to perform
location based cycle counts.

• You can use the same window to enter counts of
items requested via automatic or manual cycle
count scheduling.

• You can also enter unscheduled count entries, if
they are allowed for your cycle counts.

• You can use unscheduled counts to perform
location based cycle counts.

Oracle Inventory automatically queries up all count requests for which you have
not yet entered a count.  You can use flexible search criteria to specify the group
of count requests for which you want counts entered to speed up the count entry
process.  For example, you can specify a range of count request sequences
assigned to one person so they can be entered in the same order they were printed
on the count sheet.
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You can use a number of reports to help youYou can use a number of reports to help you
during the process of cycle counting and toduring the process of cycle counting and to
analyze and report the results of cycle countanalyze and report the results of cycle count
transactions.  You can submit a concurrenttransactions.  You can submit a concurrent
request for these reports from the Tools menu inrequest for these reports from the Tools menu in
most of the cycle counting windows as well asmost of the cycle counting windows as well as
from the Submit Requests window.from the Submit Requests window.

Cycle Count Schedule Requests Report
This report shows all scheduled requests for a specified time period.  It includes
both manually and automatically scheduled items.
Cycle Count Listing
This report lists all of the items currently due for cycle counting, including their
revision, lot number, subinventory, and locator information. Since the report
leaves a blank line for the counter’s name, the count date, and the actual count
quantity, the counter can use this listing to write down and report his cycle count
results.
Cycle Count Open Requests Listing
This report shows count requests where no counts have been entered, or count
entries where you have requested a recount.  You can optionally report on late
counts, where no counts have been entered and the due date for the count entry is
before the date of the report.
Cycle Count Unscheduled Items Report
This report shows those items that are currently not scheduled to be counted and
were last scheduled a period of time in the past that is longer than expected, as
dictated by the count frequency of the class to which the item belongs.
This report is primarily used as an auditing tool.  If you correctly set up your
scheduling and counting, and are always current in your count, Inventory should
not find any unscheduled items to report.  However, if you do not run the auto
scheduler as frequently as it needs to run, or if concurrent manager problems
prevent its execution, you may fall behind in your count schedules.
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Cycle Counts Pending Approval Report
This report shows those counts that were entered and are currently pending
approval.  The supervisor with the authority to approve cycle count adjustments
would typically run this report regularly to monitor the approval queue.
Cycle Count Entries and Adjustments Report
This report shows all cycle count entries for a specified time period.  It analyzes
the number of cycle count transactions you make against an item, and the number
of units you actually adjust.  The report also calculates the value, in your
functional currency, of the adjustments to inventory.
Cycle Count Hit/Miss Analysis
This report shows, for each cycle count class, the total number of count entries
and the number of counts outside the limits of the user-specified hit/miss
tolerances.  The report also calculates the overall accuracy percentages broken
down by cycle count class and subinventory.  This report is based on the first
count only, not recounts.
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You can import cycle count entries from external
systems into Oracle Inventory using the Cycle
Count Entries Open Interface.
You can also export cycle count requests with this
interface to external systems.

You can import cycle count entries from external
systems into Oracle Inventory using the Cycle
Count Entries Open Interface.
You can also export cycle count requests with this
interface to external systems.

Export Cycle Count Request:
This process allows you to export cycle count requests into external systems.
Update Cycle Count Open Interface:
This process allows you to update cycle count entries.
Import Cycle Count Entries from Open Interface:
This process allows you to import cycle count entries open interface records into
the database.
Purge Cycle Count Entries Open Interface Data:
This process allows you to purge all cycle count entries from the open interface.
Print Cycle Count Entries Open Interface Data:
This process allows you to print cycle count entries open interface data.
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• Initialize a Cycle Count
• Define Cycle Count Classes
• Perform Full Cycle Count
• Enter Cycle Count Entries

• Initialize a Cycle Count
• Define Cycle Count Classes
• Perform Full Cycle Count
• Enter Cycle Count Entries
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Practice 2 Solutions
1.  Initialize a Cycle Count
Manufacturing and Distribution Manager Responsibility    (N)
Inventory > Counting > Cycle Counting > Cycle Counts (B) New
Enter a unique name and description
Select the Workday Calendar (use the default calendar for this practice).
For the Adjustment Account, use the list of values and choose the
“Miscellaneous” alias.
Leave “Inactive On” blank.
Late Days = 1
Starting Seq = 1
Check the “Unscheduled Entries” Box.
Check the “Display System Qty” Box.
Under “Count Subinventories” select “Specific”
Enter the subinventory that you used for your ABC Analysis
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Practice 2 Solutions
1.  Initialize a Cycle Count (continued)
Leave “Automatic Recounts” unchecked.
Select the “Serial and Schedule” tabbed region.
Count = Not Allowed
Check the “Auto Schedule” box.
Frequency = Weekly
Leave “Count Zero Quantity” unchecked.
Leave “Last Date” and “Next Date” fields blank.
Select the “Adjustments and ABC” tabbed region.
Approval Required = If Out of Tolerance
Tolerance - Qty Variance = +3% -3%
Tolerance - Adjustment Value - +$200 -$200
Tolerance - Hit/Miss Analysis = +10% -10%
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Practice 2 Solutions
1.  Initialize a Cycle Count (continued)
ABC Initialization Group = Your ABC Group Name
Option = (Re)Initialize
Leave “Update Classes” and “Delete Unused Items” unchecked.
Save
Write down your Request ID#
View your request and verify that it has completed without error.
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Practice 2 Solutions
2.  Define Cycle Count Classes
From the Cycle Counts window, re-query your count.
Select the “Classes” button.
Your A, B and C Classes should populate the name column.
Enter the “Counts Per Year” for each class.
A = 52
B = 26
C = 13
Save.
Close the Cycle Count Classes window.
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Practice 2 Solutions
3.  Perform Full Cycle Count
From the Cycle Counts Window, re-query your count.
From the “Tools” pull down menu, select “Perform Full Cycle Count”.
A Concurrent Request window will open.
There are three requests that need parameters specified.
Click in the “Parameters” field of Generate Automatic Schedule Request.
All Cycle Counts = No
Cycle Count Name = Your Cycle Count Name
Include Control Items = No
(B) OK
Click in the “Parameters” field of Generate Cycle Count.
All Cycle Counts = No
Cycle Count Name = Your Cycle Count Name
(B) OK
Click in the “Parameters” field of Cycle Count Listing.
Cycle Count Name = Your Cycle Count Name
Start Date = Today’s Date
End Date = Today’s Date
Include Recounts Only = No
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Subinventory = The Subinventory that you chose earlier in the lesson.
Display Serial Numbers = Yes
Display Onhand Quantities = No
Items to Include = All
(B) OK
(B) Submit
Write down your Request ID number
View your request and verify that it has completed without error.



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Cycle Counting
Chapter 1 - Page 63

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 2 SolutionsPractice 2 Solutions

Practice 2 Solutions
4.  Enter Cycle Count Entries
Manufacturing and Distribution Manager Responsibility (N)Inventory
> Counting > Cycle Counting > Cycle Count Entries
Enter your Cycle Count Name
(B)Find
Find All Open Count Requests? = Yes
Navigate to the “Adjustments” Tabbed Region
Record some counts that will be out of the tolerances that you set up earlier in the
lesson and record some counts that are within the tolerances or exactly correct.
Save
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Cycle counting of serial items takes place within
the standard cycle counting functionality in
Inventory.  However, there are additional
considerations specific to serialized cycle
counting that will be discussed in this lesson.

• Counting method
– Detail level
– Adjustment approach
– Discrepancy treatment

Cycle counting of serial items takes place within
the standard cycle counting functionality in
Inventory.  However, there are additional
considerations specific to serialized cycle
counting that will be discussed in this lesson.

• Counting method
– Detail level
– Adjustment approach
– Discrepancy treatment
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There are four options in the Cycle Counts window
that govern the handling of serial controlled items:

• Count
• Detail
• Adjustment
• Discrepancy

There are four options in the Cycle Counts window
that govern the handling of serial controlled items:

• Count
• Detail
• Adjustment
• Discrepancy

Count
If this option is set to Not Allowed, then serialized items are excluded from the
cycle count.
If this option is set to One Per Request, then a separate count request is generated
for each serial number.
If this option is set to Multiple Per Request, then serial numbers for the same
item/location are grouped into one count request.
Detail
If this option is set to Quantity and Serial Numbers, then serial number an
quantity are required and are validated when entering counts.
If this option is set to Quantity Only, then serial number entry is required if the
count quantity does not match the system quantity.  Serial number entry is
optional if the count quantity matches the system quantity, regardless of whether
the serial numbers match.
Adjustment
If this option is set to Review All Adjustments, then no automatic adjustments are
attempted.  Serialized items that require adjustment must go to an approver for
review.
If this option is set to Adjust if Possible, then if a discrepancy exists between the
count quantity and system quantity or if the entered serial numbers do not
correspond to the serial numbers already in the specified location, then the system
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will attempt to make adjustments if the adjustment variance and value are within
tolerances, as long as serial uniqueness constraints are not violated.
Discrepancy
If this option is set to Allow Discrepancies, then when a count includes a serial
number already assigned to the same item elsewhere in the system, an adjustment
is created if it would be within quantity or value tolerancies.  No adjustment is
ever allowed for counts including serial numbers already assigned to another item.
If this option is set to Do Not Allow Discrepancies, then adjustments are not made
for items not found in the specified location.  The items must then be recounted to
eliminate discrepancies.
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How you enter serialized cycle counts depends on
the Count and Detail option settings in the count
definition.  When the Count option is set to One
Per Request and the Detail option is set to
Quantity Only, the count request itself contains
the serial number, and you enter a count quantity
of either present or missing.

How you enter serialized cycle counts depends on
the Count and Detail option settings in the count
definition.  When the Count option is set to One
Per Request and the Detail option is set to
Quantity Only, the count request itself contains
the serial number, and you enter a count quantity
of either present or missing.

When the Count option is set to Multiple Per Request and the Detail option is set
to Quantity and Serial Numbers, the Serial Number field in the count request is
disabled, and you must use the Cycle Count Serial Detail window to specify
whether the serial number is present.  If you selected Quantity Only as the Detail
option, you must use the Cycle Count Serial Number Details window if there is a
quantity mismatch.
It is possible to have count requests for serial numbers with an on-hand quantity
of zero.  If you mark the serial number as present, then you will need to make an
adjustment to your count.
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Approving and Adjusting Serialized
Counts

The approval process for serialized items differs
from that for non-serialized items.  Serial numbers
that are misplaced (at a different location or for a
different item) cannot be adjusted.

The approval process for serialized items differs
from that for non-serialized items.  Serial numbers
that are misplaced (at a different location or for a
different item) cannot be adjusted.

Counts in which there is a misplaced serial number are sent for approval,
regardless of whether the adjustment variances fall within tolerance if
discrepancies are allowed.  However, if a count entry contains a serial number
found in another location, the count request cannot be approved until the
discrepancy is corrected.  You can make the correction manually in the
Transaction window, or you can cycle count the other location (performing an
issue, adjustment transaction) and then recount the first location.
For serial numbers that do not appear in the cycle count request but are entered by
the counter, adjustment transactions are considered receipts.  These receipt
transactions are allowed for the serial statuses where the unit is defined but never
used and where the unit has been issued out of stores.  For serial numbers that
appear in the count request but are not marked as present by the counter,
adjustment transactions are considered issues.  These issue transactions are
allowed for the serial status where the unit is received into stores.  Count requests
whose serial adjustments fall into these two categories may have adjustment
transactions performed against them and may complete normally.
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Once you enter and save your cycle counts,
Oracle Inventory determines whether any
adjustments need to be made depending on the
approval options and tolerances you set when you
defined the cycle count.

Once you enter and save your cycle counts,
Oracle Inventory determines whether any
adjustments need to be made depending on the
approval options and tolerances you set when you
defined the cycle count.
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• If you turned the Automatic Recount option on
when you defined your cycle count, Inventory
automatically submits recount requests for items
that are outside the limits of the approval
tolerances you specify.

• Inventory submits recounts as many times as
necessary, limited by the maximum automatic
recounts you specify for the cycle count.

• After you reach the maximum number of recounts,
Inventory holds the count for approval.

• Any count request with the Recount status
automatically appears on the next cycle count
listing

• If you turned the Automatic Recount option on
when you defined your cycle count, Inventory
automatically submits recount requests for items
that are outside the limits of the approval
tolerances you specify.

• Inventory submits recounts as many times as
necessary, limited by the maximum automatic
recounts you specify for the cycle count.

• After you reach the maximum number of recounts,
Inventory holds the count for approval.

• Any count request with the Recount status
automatically appears on the next cycle count
listing

You can manually request recounts when you are approving adjustments.  This
recount request will be included in the next cycle count listing.
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Approving Cycle Counts Held for
Approval

• Employees with access to the Count Adjustments
Approvals Summary window can query, request
the recount of, or approve cycle counts pending
approval.

• You can query all counts or only those pending
approval.

• You can approve adjustments, recount an item in
question, reject the count or take no action until
further investigation takes place.

• Employees with access to the Count Adjustments
Approvals Summary window can query, request
the recount of, or approve cycle counts pending
approval.

• You can query all counts or only those pending
approval.

• You can approve adjustments, recount an item in
question, reject the count or take no action until
further investigation takes place.
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• You use the Count Adjustment Approvals
Summary window to approve cycle count
adjustments, to request/approve recounts, or to
reject the adjustment.

• Inventory determines which counts need approval
by using the approval tolerances you entered
while defining your cycle count.

• You can use flexible search criteria to specify the
cycle count adjustments you want to review or
approve.

• You use the Count Adjustment Approvals
Summary window to approve cycle count
adjustments, to request/approve recounts, or to
reject the adjustment.

• Inventory determines which counts need approval
by using the approval tolerances you entered
while defining your cycle count.

• You can use flexible search criteria to specify the
cycle count adjustments you want to review or
approve.
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Inside the Count Adjustment Approvals Summary
window, you can view a variety of current item
information to help determine whether to approve
an adjustment.  Select the information from the
following tabbed regions:

• Adjustment:  View information for the count
adjustment UOM, variance quantity, variance
value, variance percentage and system quantity.

• Revision, Subinventory, Locator:  View
information for revision, subinventory, locator,
unit of measure and adjustment quantity.

Inside the Count Adjustment Approvals Summary
window, you can view a variety of current item
information to help determine whether to approve
an adjustment.  Select the information from the
following tabbed regions:

• Adjustment:  View information for the count
adjustment UOM, variance quantity, variance
value, variance percentage and system quantity.

• Revision, Subinventory, Locator:  View
information for revision, subinventory, locator,
unit of measure and adjustment quantity.
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• Lot:  View information for a lot number, unit of
measure, adjustment quantity and serial number.

• Reason, Reference:  View or update the
transaction reason and reference information.
You can also view the unit of measure and
adjustment quantity.

• Count:    View information for UOM, count
quantity, counter and count date.

• Count Status, Class:  View information for the
sequence number, count status and cycle count
class

• Approval:   View information for date approved
and approver.

• Lot:  View information for a lot number, unit of
measure, adjustment quantity and serial number.

• Reason, Reference:  View or update the
transaction reason and reference information.
You can also view the unit of measure and
adjustment quantity.

• Count:    View information for UOM, count
quantity, counter and count date.

• Count Status, Class:  View information for the
sequence number, count status and cycle count
class

• Approval:   View information for date approved
and approver.
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• For items appearing in the Approval Actions,
Adjustments region, you can approve, request a
recount, or reject cycle count entries that are
pending approval.

• You can also approve or reject any count for
which a recount has already been requested.

• You can reject any cycle count request that has
not yet been counted.

• You can display count history information or open
the Count Adjustment Approvals window.

• For items appearing in the Approval Actions,
Adjustments region, you can approve, request a
recount, or reject cycle count entries that are
pending approval.

• You can also approve or reject any count for
which a recount has already been requested.

• You can reject any cycle count request that has
not yet been counted.

• You can display count history information or open
the Count Adjustment Approvals window.

•     Select Approved to approve the selected count entry and post the 
adjustment to the transaction manager for processing.
•     Select Rejected to reject the selected count record.  An adjustment is not
posted.  No further processing of this count entry takes place.
•     Select Recount to process a recount request for the selected count request.  An
adjustment is not posted.
•     Select the Count History button to open the Count History window for the
current item.  For the current item, this window displays count and variance
information for the current, prior and first counts.
•     Select the Open button to open the Count Adjustment Approvals window
for the current line.  This window is a combination block which you can use to
view and enter approval and adjustment information for the current line instead of
using the Count Adjustment Approvals Summary window.
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• Enter Approved Counts
• Adjust Approved Counts
• Reject Counts

• Enter Approved Counts
• Adjust Approved Counts
• Reject Counts
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Practice 3 Solutions
1.  Count Adjustments and Approvals
Manufacturing and Distribution Manager Responsibility (N)Inventory
> Counting > Cycle Counting > Approve Count
Enter your Count Name
(B)Find
At this point you have the option to “Query Counts Pending Approval Only”.  If
you select NO, then you will see all the items that have been sent for approval and
those items that have not yet been counted.  If you select YES, then you will only
see the items that need approval.
In the Defaults region, you can optionally change the Date, Approver and the
Adjustment Account.
You can view the count history of any item by pressing the Count History button.
Approve one of your counts.
Reject one of your counts.
Recount one of your counts.
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You should now be able to do the following:
• Create an ABC Compile
• Define and Maintain a Cycle Count
• Describe Serialized Cycle Counting
• Demonstrate Count Adjustments and Approvals

You should now be able to do the following:
• Create an ABC Compile
• Define and Maintain a Cycle Count
• Describe Serialized Cycle Counting
• Demonstrate Count Adjustments and Approvals
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